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AKVIS MAGNIFIER AI 12.0 | ENLARGE IMAGES & ENHANCE QUALITY

AKVIS Magnifier AI allows you to enlarge and enhance images. The software uses trained neural networks for image
upscaling. The program works well for various purposes: to enlarge photographs, artworks, low quality web images, photos
with text, etc. Increase the resolution and quality of your photos with Magnifier AI!

 

AKVIS Magnifier AI is an efficient program for increasing image size without loss in quality. Whether creating poster-size
images or adding resolution for better printing quality, the program makes your enlarged image look crisp and clear!

If you attempt to blow up a picture using the resizing tools of a photo editor, you will notice that the resulting photo is
blurred, pixelated, and blocky. The reason is that the input photo didn't contain enough information for the new size.

With AKVIS Magnifier AI, you can create a high-quality enlarged image from a small one. The program allows you to increase
the image size up to 800%.
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The program uses innovative technologies of artificial intelligence and machine learning and allows you to create clear,
detailed images with perfect quality.

AKVIS Magnifier AI includes two upscaling AI-based modes: Standard and Intensified.

Standard mode is recommended to process photos of good quality without noticeable noise and compression artifacts. In
this mode, Magnifier AI enlarges images, preserving details and texture, and enhancing contrast.
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Intensified mode is great for illustrations, artworks, images with text, screenshots, low-res images from the Internet, and for
preparing super-large prints. In this mode, the program enlarges images providing powerful noise removal and defects
compression features, emphasizing edges on a picture.
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The software does a magnification work without color distortion and without drawing unnecessary details, which is a
disadvantage of many other neural networks.

This AI-powered program allows enlarging an image to a super-high resolution, making large format gigapixel posters and
panoramas. It's an indispensable tool for professionals.

The program keeps edges smooth, sharp, and clearly defined while removing unwanted noise and compression artifacts.

AKVIS Magnifier AI makes it easy for anyone to produce professional-looking high-quality images. Apply the program to
enlarge pictures from social networks or messengers, photos taken with a low-resolution camera, or post-crop results.

Magnifier AI is a useful tool for quickly resizing multiple images at once. The Batch Processing feature lets you
automatically upscale or downscale a series of images, applying the cutting-edge algorithms to a folder full of photos.
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This photo resizing software can be used as a standalone program and/or plugin in Adobe Photoshop and Adobe
Photoshop Elements. 
To call the Magnifier AI plugin in Adobe Photoshop, select the menu item File -> Automate -> AKVIS Magnifier AI
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows. We took AKVIS Magnifier AI as an example.
Other AKVIS programs are installed in the same manner.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

Note: You can launch almost all AKVIS plugins from the menu Filter, except AKVIS Magnifier AI. To call the Magnifier AI
plugin in Photoshop please use the command File -> Automate -> AKVIS Magnifier AI, in Photoshop Elements: File ->
Automation Tools -> AKVIS Magnifier AI. The plugin does not work with other image editors.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer. We took AKVIS Magnifier AI as an example. Other
AKVIS programs are installed in the same manner.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-magnifier-app.dmg to install the Standalone version

- akvis-magnifier-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Magnifier AI application or AKVIS Magnifier AI PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Magnifier AI app into the folder Applications (or any other place
you like).

To install the Plugin, drag the entire AKVIS Magnifier AI PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

Note: You can launch almost all AKVIS plugins from the Filter menu, except AKVIS Magnifier AI. To call the Magnifier AI
plugin in Photoshop, please use the command File -> Automate -> AKVIS Magnifier AI, in Photoshop Elements: File ->
Automation tools -> AKVIS Magnifier AI.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer. We took AKVIS Magnifier AI as an example. Other
AKVIS programs are installed in the same manner.

You can use only the standalone applications by AKVIS on computers with Linux OS. We are working on the plugins
compatibility.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

AKVIS installers are available for several Linux distributions:

► DEB package: Debian/Ubuntu

► RPM package: Red Hat/CentOS/Fedora

► openSUSE

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS Magnifier AI 
sudo apt-get install akvis-magnifier

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-magnifier --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS Magnifier AI:

when using the dnf package manager: 
sudo dnf install akvis-magnifier

when using the yum package manager: 
sudo yum install akvis-magnifier

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade
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when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-magnifier

when using the yum package manager: 
sudo yum remove akvis-magnifier

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS Magnifier AI: 

zypper install akvis-magnifier
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-magnifier

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Magnifier AI and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Magnifier.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS Magnifier AI can work independently as a standalone program as well as a plugin in Adobe Photoshop and Photoshop
Elements.

Standalone is an independent program. You can run it in the usual way.
Plugin is an add-on for graphics editors. Magnifier AI works with Adobe Photoshop and Photoshop Elements. It supports
the automation function and can be find in Automate menu of Photoshop, in the Automation Tools of Photoshop
Elements (unlike other AKVIS plugins, which are available in the Filter menu). The layers must be merged before calling
the plugin.

 

Windows-version: When you first start the program, if a computer allows, a message will appear about the possibility to
download and install the CUDA module for working with neural networks.

 

The AKVIS Magnifier AI workspace looks like this:

Workspace of AKVIS Magnifier AI

Parts of the program's window:

The left part of AKVIS Magnifier AI’s workspace is taken by the Image Window with two tabs Before and After. The
Before tab displays the original image, the After tab shows the result. You can compare the original and the resulting images
by just left-clicking on any point of the image.

You can select how Image Window and Before/After tabs will be shown by adjusting the View Modes in the bottom part
of the left panel.

Attention! When switching between the tabs you can notice a slight distortion of the image proportions. This visual
effect is a result of simultaneous scaling of two images; it will have no influence on the final result. To minimize this
effect, it is recommended to work with images using certain scales (50%, 100%, 150% etc).

 

In the upper part of the program's window you can see the Control Panel with the following buttons:
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The button  opens the home page of AKVIS Magnifier AI.

The button  (only in the standalone version) opens an image for processing. Right mouse click on this button

displays the list of recent files. You can change the number of recent documents in the Preferences dialog box. The
hot keys are Ctrl+O  on Windows, ⌘ +O  on Mac.

The button  (only in the standalone version) saves the image to the disk. The hot keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hot keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.
The button  initiates image processing with specified set of parameters.

The button  (only in the plugin version) applies the result. When you press the button, the changes are applied to

the image and the plugin's window closes.
The button  calls information about the program.

The button  calls help files to the program. The hot key for this operation is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about Magnifier AI.

 

Тo the left of the Image Window there is the Toolbar with these tools:

The button  (only in the standalone version) activates the Crop tool which allows cutting off unwanted areas in the

image.
The button  activates the Hand tool which allows you to scroll the image when it does not fit within Image

Window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left
mouse button pressed move in the desired direction.

Double-clicking on the tool's icon  on the Toolbar makes the image fit the Image Window.

The button  activates the Zoom tool, which changes the image's scale. To zoom in left click on the image. To zoom

out left click with Alt  on the image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  on the Toolbar makes the image scale to 100% (actual size).

And below, there are three buttons which control how the Image Window looks like.

 

Navigate and scale the image using the Navigator. In the Navigator you can see the reduced copy of the image. The red
frame shows the part of the image that is now visible in the Image Window; the areas outside the frame will be shaded.
Drag the frame to make other parts of the image visible. To move the frame, bring the cursor inside the frame, press the left
mouse button and, keeping it pressed, move the frame in the Navigator.

Navigator

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then
holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and
holding Ctrl  on Windows, ⌘  on Mac – while using the scroll wheel will move the image left and right. Holding  Alt  on

Windows, Option  on Mac will scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some
frequently used coefficients.
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You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator there is a Settings Panel with parameters of advanced image processing.

In the Presets field you can save the current settings as a preset to use them in the future. When you launch the program,
it uses the settings of the last used preset.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You
can choose where the hints will be shown or hide them in the program's Preferences.

 

AKVIS Magnifier

20



IMAGE VIEW MODES: BEFORE AND AFTER

At the bottom of the Toolbar of AKVIS Magnifier AI, there are three buttons which let you choose how the Image Window
will look like and arrange the Before and After tabs.

Click the first button to open a submenu that contains various options for viewing the original and processed images:

- The button  provides the standard image window mode with two tabs: Before and After.

- The buttons  and  divide the main window into two parts, vertically or horizontally, respectively. The

original and processed images become partially visible and the tabs are combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Before and After
parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as well. However, in

contrast to the previous option, the windows display the same fragment of the image before and after
processing.

Note: Use two windows side by side when you want to see and compare the original and processed versions of an
image fragment on one screen. If you would rather see the final image as a whole, you can choose the standard image
view mode.

The button  swaps the positions of the original image and result when displaying two windows.
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The 3rd button lets you choose the background color of the Image Window. Pressing , , or  changes the

background color to white, gray, or black, while clicking on  opens the Select Color dialog where you can choose a

color of your choice.
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HOW TO USE THE PROGRAM

AKVIS Magnifier AI lets you change the size of an image without loss in quality. The software allows enlarging an image to a
super-high resolution. Whether creating poster-size images, adding resolution for printing, or reducing image size, AKVIS
Magnifier AI will make your images look crisp and clear!

Compare the image increased by 800% with the original one.

Image Enlargement with Magnifier AI

AKVIS Magnifier AI can work independently as the standalone application and as plugin in Adobe Photoshop and Photoshop
Elements.

In order to resize an image, perform the following steps:

Step 1. Open an image.

- If you work with the standalone edition (use a file in JPEG, RAW, PNG, BMP, WEBP, or TIFF format):

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on the button  on the Control Panel. You can also drag the required image into the workspace of the

program.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows, ⌘ +O  on Mac.

Attention! Unlike other AKVIS plugins (which are available in Filter menu), you will find the Magnifier AI plugin in
the automation features of Photoshop.

Make sure that layers are merged otherwise the plugin can't be called, and select the menu item:

File -> Automate -> AKVIS Magnifier AI in Adobe Photoshop;
File -> Automation Tools -> AKVIS Magnifier AI in Adobe Photoshop Elements.
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AKVIS Magnifier AI

Step 2. Before resizing, in the standalone version, you can use the Crop tool  to trim a part of the picture. The tool

is useful when you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a
vertical one and contrariwise.

Note that the tool is applied to the original image! First use the tool, then change the image size.

Change the crop area by dragging the sides and the angles of the bounding frame. Use the buttons in the Settings
Panel to control the tool. To apply the result and remove the areas outside the frame, click OK or use Enter . To

cancel the operation and exit the tool, press Cancel or use the Esc -key. To restore the original area keeping the tool

active, press Reset.

Crop

Step 3. You can choose one of the built-in presets or set the required size change (New Size) into the Width or
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Height field (in pixels, per cent, cm, mm or inches). You can enlarge an image up to 800%.

Adjust the Resolution. If you are going to print the image it's recommended to use 300 dpi, for web - 72 dpi.

Resize Image

Step 4. Depending on the New Size value, different additional parameters will be active: Upsize or Downsize.

Upsize (Image Enlargement)

For image upscaling, the program uses innovative technologies of artificial intelligence and machine learning.

Select an image resizing algorithm depending on the AI model:

A. Standard. It allows you to enlarge photos, preserving details and texture and enhancing contrast. It's
recommended to process photos of good quality without noticeable noise and compression artifacts.

B. Intensified. It allows you to enlarge images providing noise removal and defects compression, emphasizing
edges on a picture. It works great for illustrations, artworks, images with text, low-res images from the Internet,
and for preparing super-large prints.

The AKVIS presets created using a particular mode are labeled A or B, respectively.

Standard Mode
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Smoothing = 0 Smoothing = 20

Sharpness = 0 Sharpness = 80

Intensified Mode

In different cases, different methods work better. The choice of a neural network depends on the original image quality,
as well as on the desired result. Compare modes.

In addition to the work of the neural network, you can adjust an auxiliary parameter:

Smoothing (0-25). Preliminary smoothing of irregularities in the image. Higher values cause blurring.

Downsize (Image Reducing)

Adjust the parameters:

Sharpness (0-100). The parameter increases image sharpness by intensifying the color contrast between the
neighboring pixels. The higher the value of the parameter, the sharper the image becomes.

AKVIS Magnifier

26



Remove Noise = 0 Remove Noise = 25

Remove Noise (0-25). The parameter lets removing noise and defects by increasing the level of smoothness.
The higher the value, the smoother the result is.

Step 5. If you do not use Autorun Mode, click  to process the image with the adjusted settings.

To be able to see the result of the parameters' change at once it is recommended to activate Autorun Mode (see
Preferences). The image will be scaled to 100%. In this mode any change in the settings or navigation on the image
will result in an automatic start of image processing.

To interrupt the process, click the Cancel button right to the progress bar.

Attention! Increasing an image's size is a resource-intensive process and requires a substantial RAM capacity
and 2-3 Gb of free space on disk C:/ for swap-files. When increasing a 5-10 megapixel image by 400%, the image
area increases by 16 times + 200-300 Mb; in this case the processing will consume about 1.5 Gb RAM.

Step 6. It is possible to save the settings you like as a preset and use them in the future. To save a preset, enter a
name for the preset into the Presets field and press the button Save.

The settings of the selected preset will be used as default settings. If you change the values of the parameters, you
can always come back to the default settings of the preset with a click on the button Reset. To process an image with
the settings of a certain preset, you should select it from the drop-down menu and press the button . To delete a

preset, select it from the list and press Delete.

Presets

Step 7. In the standalone program, you can also print your result using .

Step 8. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save as dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG, WEBP, or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS Magnifier AI plugin will close

and the resized image will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.

Below you can see the result of image scaling with parameters, presented in the screenshot.
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Four-fold Magnified Image Fragment
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This option defines the way the image is scaled in the Image Window.

- Fit to View: the image is completely visible in the window;
- 100%: the image doesn’t scale (generally, only a part of the image is visible).

Autorun Mode. In this mode any change in the settings or navigation on the image will result in an automatic start of
image processing. When the Autorun Mode is Off, the image processing starts by pressing the button .

Hints. When you hover over parameters and buttons with the cursor you can see a brief description of them in the
Hints field. You can choose how the hints will be shown:

- Under Image Window. It shows the hints in the main window, under the image. This mode is useful if there is
not enough space by height to display this field under the settings;
- Under Settings Panel. Select this to show hints at the bottom of the right part, under the settings;
- Hide. Use this option if you do not need the hints.

Recent Files (available only in the standalone version). The parameter sets the number of recent files, sorted by time,
displayed in the list by right-clicking on  (maximum: 30 files).

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on
the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
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BATCH PROCESSING

AKVIS Magnifier AI supports batch processing that lets you automatically process a series of images.

Batch processing is useful when dealing with a lot of photos taken under the same conditions with identical camera settings.
It saves you time and effort. With Magnifier AI you can resize a lot of photos in an automatic mode.

 

Batch image resizing is simple with AKVIS Magnifier AI!

Standalone: Learn how to work in the Batch mode.

Plugin: Follow the instructions.

The plugin works only with one-layered images!

In Photoshop, find the plugin here: File -> Automate -> AKVIS Magnifier AI.
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PRINT IMAGES IN AKVIS MAGNIFIER AI

In the standalone version of AKVIS Magnifier AI you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Magnifier AI

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.
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Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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COMPARISON OF IMAGE ENLARGEMENT MODES

AKVIS Magnifier AI lets you increase images up to 800%. You can choose from these modes based on the neural networks:

Standard. The algorithm is designed to enlarge photos saved in good quality without noticeable noise and compression
artifacts. When processing an image, it preserves fine details and texture, but can consider noise pixels as important
details and increase them too.

Intensified. The algorithm is designed to enlarge photos saved in low quality, as well as artworks, illustrations,
drawings, and images with text. When enlarging an image, it removes noise and compression defects, and emphasizes
edges, but can also smooth out fine details or texture in an image.

 

Let's compare image enlargement methods in Magnifier AI on different images. Depending on the original image quality and the
desired result, one or another mode suits better.

Example 1. A landscape high-quality photo with many small details.

Original Image
(click the image to open a larger version)

4X enlargement using the Standard mode. Most of the details are preserved.
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Standard Mode
(click the image to open a larger version)

4X enlargement using the Intensified mode. Small details are smoothed out, and the image looks more like a drawing than a
photograph.

Intensified Mode
(click the image to open a larger version)

 

Example 2. An interior photo in medium quality.
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Original Image
(click the image to open a larger version)

4X enlargement using the Standard mode. The texture is partially restored.

Standard Mode
(click the image to open a larger version)

4X enlargement using the Intensified mode. Most of the small details are smoothed out, and the objects on the photo get a
clear but plastic look.
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Intensified Mode
(click the image to open a larger version)

 

Example 3. A noisy portrait photo saved in high quality.

Original Image
(click the image to open a larger version)

4X enlargement using the Standard mode. Digital noise is preserved and takes the form of large grains.
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Standard Mode
(click the image to open a larger version)

4X enlargement using the Intensified mode. Digital noise is completely removed.

Intensified Mode
(click the image to open a larger version)

 

Example 4. A photo of a snake saved in low quality.
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Original Image
(click the image to open a larger version)

4X enlargement using the Standard mode. Noise and compression artifacts are preserved.

Standard Mode
(click the image to open a larger version)

4X enlargement using the Intensified mode. Noise and compression artifacts are gone, the snake scales and all contours look
smooth and clear.
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Intensified Mode
(click the image to open a larger version)

 

Example 5. An illustration saved in low quality.

Original Image
(click the image to open a larger version)

4X enlargement using the Standard mode. Compression artifacts are preserved.
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Standard Mode
(click the image to open a larger version)

4X enlargement using the Intensified mode. Compression artifacts are gone, the image gets smooth edges and uniform
areas.

Intensified Mode
(click the image to open a larger version)

 

Conclusion. As you can see, the choice of an enlargement algorithm depends on the quality and content of the original
image, as well as on the desired result. If the quality of the image is high enough and you want to save more details, use the
Standard algorithm. If the quality of the image leaves much to be desired, or the result does not require excessive details, it
is better to use the Intensified algorithm that better smoothes and gets rid of noise and artifacts.
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FUNNY FLEAS: IMAGE SCALING

There is a notion of infinite regression in logic that describes a process of change that goes on and on and never stops. A
graphic example for this phenomenon gives a funny verse about fleas ascribed to Scottish mathematician August de Morgan
(19 century):

 

Great fleas have little fleas upon their backs to bite ‘em,
And little fleas have lesser fleas, and so ad infinitum.
And the great fleas themselves, in turn, have greater fleas to go on,
While these again have greater still, and greater still, and so on.

This story tells us about an infinite increase (reduction) of the size of fleas living on each other. We will illustrate some of the
stages of this process using AKVIS Magnifier AI, an image resizing program.

 

Step 1. Launch the program AKVIS Magnifier AI.
Step 2. Open the original image with a double click of the left mouse button on the Image Window. Activate the
Autorun mode (see Preferences) for the program to process the image automatically, every time you change the
settings.

Original image

Step 3. Reduce the image twice. For this purpose set the new size into the New Size field: select per cent in the
drop-down menu and enter 50 into the Width or into the Height field. To improve the image quality on the scales lower
than 100% use the Sharpness parameter. In this case the original color range is restored with the default settings of
parameter.
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Reduce the image twice

Save the image as little-flea.jpg by clicking on  and entering a name for the file into the Save as field. Before the

image is saved, the whole image will be processed (like with a click on ).

Step 4. Reduce the image by 4 times. Enter 25 into the Width or into the Height field.

Reduce the image by 4 times

Save the result as little-little-flea.jpg.

Step 5. Increase the original image twice: enter 200 into the Width or into the Height field.

Increase the original image twice

Save the result as big-flea.jpg.

Step 6. Increase the original image by 4 times: enter 400 into the Width or into the Height field.

Increase the image by 4 times

Save the result as big-big-flea.jpg.

Step 7. Close the program AKVIS Magnifier AI.

Fleas biting each other
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PAPARAZZI: ON THE HUNT FOR THE LATEST SENSATION

Keep your eyes peeled! Seize the moment! Find something sensational!

The paparazzi have waylaid an unsuspecting couple. As they close in all sides and flock to the stairs, they begin to shoot. As
usual, their attention is drawn to the tidbits of the meeting. The next day, the newspaper's headline reads: "Billionare's Son Is
Dating...", and adorning the front pages are close-ups of their rendezvous.

 

Quite often attention is not drawn to an entire image but to certain details. In such cases an image will be cropped to focus
on these details. This technique is often used in photography to remove the unnecessary elements in the background, get a
close-up, and thus draw attention to one detail.

As a rule, the image, post-crop, is smaller than the original. This leads to the problem of returning the image to its original
size while maintaining image quality. This is where AKVIS Magnifier AI comes in.

 

Step 1. Open the image in AKVIS Magnifier AI. Here's a shot of the couple's hands made by the paparazzi:

Original Image

Step 2. Use the Crop tool  to select the desired fragment from the image. A true paparazzi would choose their kiss:

Cropping the Image

Step 3. Select the unit of measurement in the Settings Panel and choose a size of the image with a resolution no less
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than 300 dpi. If you want to create a huge sensation, your image should be bigger.

AKVIS Magnifier AI Workspace

Step 4. Process the image by pressing  and save the result by pressing .

Paparazzi Photo
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TOM THUMB: INCREASING RESOLUTION

The author of this tutorial is Gordon Sisson.

In his example, Gordon Sisson has demonstrated one more aspect of the usage of AKVIS Magnifier AI - namely the ability
not only to change the image's dimensions but also to improve on its quality. In author's words he frequently needs to
increase the resolution of graphics dragged off the internet or clip art collection. These graphics are 72 dpi which is not
acceptable for printing, so resolution should be increased to 300 dpi.

Gordon Sisson decided to magnify a photo of a little boy. As everyone knows, growing a child is a very involved process. Let
alone the boy is really small - the original image is just of 2.38 inches high! The author claims, however: this task can be
done in just a couple of minutes.

Here is the Magic of AKVIS Magnifier AI:

Step 1. Start AKVIS Magnifier AI and open the .tif image (drag it into the program's window).

Original Photo of a Little Boy

Step 2. Increase the Resolution to 300 dpi. This reduces the size to 0.57 inches high.

Resolution change from 72 to 300 dpi

In the New Size panel specify the final size you want (as percent of the reduced size of the original graphic — in this
example 750%).

New Size

Step 3. Choose an enlargement algorithm A/B. We used A. Standard.

Click on the button  to process the image with the adjusted settings. The image height is now 4.28 inches - the

boy has become two times taller and the image resolution experienced a four-fold increase.
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AKVIS Magnifier AI program's window

Save the final image – now it can be printed.

This method produces a graphic of higher quality than the laborious procedure in some image editors.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
original quality of compressed images. The software is available free of charge. It is a must for both home users and
professionals. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture!
More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…
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AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos
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AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

 

AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…
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AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches
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AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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